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Welcome 
Welcome to MyBowlingDiary! By using MyBowlingDiary, you are telling yourself that 
you are serious about improving your bowling, and having the proper information at your 
fingertips is an important step in that process.  
 
This user guide contains instructions for using the PC version as well as our new 
handheld versions (for Pocket PC and Palm Pilot users). 
 
If you are using MyBowlingDiary for the first time, please read below for some useful 
tips and information. 
 
Here are some suggestions to get you started on the right track with MyBowlingDiary: 

1. If you own the full version of MyBowlingDiary, please register your copy by 
visiting http://www.mybowlingdiary.com/reg_intro.htm. Registration only takes a 
couple of minutes, and is fast and easy. Refer to the “Registration” section for 
more information and instructions. 

2. If you are using the trial version, you will want to install and activate the product 
as soon as possible as the license key has a limited evaluation period. 

3. Read this user manual. You may also want to put a shortcut to the manual on your 
desktop for quick reference. 

4. Review the README file supplied with the installation package to get 
information on known issues. You can also visit 
http://www.mybowlingdiary.com/support.htm to look up known support issues. 

5. Review the license agreement, and the section on getting support. The license 
agreement should have been enclosed as a separate document with the installation 
package. If you need a copy of the license agreement, please send an email to 
support@mybowlingdiary.com. 

 
For clarity, MyBowlingDiary will be referred to in this document as MyBowlingDiary or 
MBD. 

Installation 
For installation of MyBowlingDiary, please refer to the MyBowlingDiary 2.0 Install 
Guide that was included with your package. If you do not have this document, please 
contact support@mybowlingdiary.com to receive a copy. 

Licensing 
MyBowlingDiary requires a license key for operation. This license key is provided to you 
when you purchase the product or request a download of the trial version. There are three 
types of licenses available: 

• Trial license: A trial license is valid for 14 days after installation, and has an 
expiration date.  

• Permanent license, non-handheld: This is a permanent license of 
MyBowlingDiary to allow you to use the full PC version with no expiration. This 
does not include support for our handheld offering. 
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• Permanent license, handheld: This is a permanent license of MyBowlingDiary 
that allows you to use the full PC version with handheld support. 

 
The type of license you have depends on the version you have purchased. You can check 
your license status in one of two ways: 

(1) When you launch MyBowlingDiary, you will see a pop-up window that looks like 
this: 

 
    Figure 1 - License Status Screen 

 
 

(2) You can also go to “Database Tools” from the Main Menu and click “License 
Status” to see the same window as in Figure 1. 

 
The license key is provided to you via email when you purchase the product or download 
the trial version. If you own a permanent license, we recommend that you do the 
following: 

• Keep a record of your license key. Should you need to re-install MyBowlingDiary 
for any reason, you will need the license key. 

• Do not give out the license key to anyone. 
• If for some reason you need to contact Technical Support, you only need to 

provide your serial number. Our support staff will never ask you for your license 
key. 

 
The license key is maintained in a configuration file named “mybdcfg.conf” located in 
C:\Program Files\Common Files\MyBowlingDiary. We recommend that you do not edit 
or delete this file. 

Other Information 
• An active Internet connection is NOT required to run MyBowlingDiary.  
• MyBowlingDiary uses a Microsoft Access database to maintain your information. 

We recognize that you may be very familiar with Access, however, we do not 
support the editing of the MyBowlingDiary database schema, or editing of data 
directly via the Access interface. Doing so without direct instruction from 
MyBowlingDiary support can render your database and MyBowlingDiary 
inoperable. You are, however encouraged to use the database compression tools 
within Access to compress and maintain your database to a reasonable size. 
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Frequently Asked Questions 
The following are a few frequently asked questions with regard to MBD, and you 
probably have the same questions yourself: 
 
Q: Do I need to install Microsoft Access in order to use MBD? 
 
A: The installation of MyBowlingDiary will install the necessary components in 
order for MBD to communicate with the database. However, having Microsoft 
Access installed is recommended should you need to occasionally compress your 
database. If you do have MS Access installed on your system please DO NOT 
modify the database schema, as this will render MBD inoperable. 
 
Q: Can I use another database format? 
 
A: For reasons of portability, simplicity and to keep the cost of the program as low 
as possible, MyBowlingDiary was written specifically to use a Microsoft Access 
database.  
 
Q: Must I create the database? 
 
A: The installation process will install all of the necessary files and programs for you 
to be able to start using MyBowlingDiary within minutes. 
 
Q: Do I need to know any database specifics? 
 
A: MyBowlingDiary provides you with an easy-to-use interface. MBD takes care of 
all of the necessary “behind the scenes” work to get the information into the 
database, so no knowledge of databases is required. 
 
Q: What information must I put into MBD? 
 
A: One of the features of MBD is its flexibility. We realize that some customers do 
not keep all of their information. If all you want to do is enter your game scores, 
that is OK. If you want to enter your frame by frame pinfall, that is OK too. If you 
are worried about taking notes or don’t know where to start, don’t worry. For some 
tips on getting started see “Taking Notes” in this manual. However, the most 
important tip is to do what works for you. 
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Using MyBowlingDiary for Handhelds 
The following instructions are for using MyBowlingDiary for handhelds. Note that the 
screen shots shown in this document may not be fully representative of the screens you 
will see on your handheld. The operation is basically the same, but differences between 
the two handhelds will be noted. 

Known Issues 
The following are known issues with this release (v2.xH) and will be corrected in a later 
release: 

(1) When adding frames to a game, you will more than likely see the screen flashing 
along with “Lane #” flashing in the window. 

(2) If you do not enter a complete game (i.e. a game less than 10 frames), this will 
sync with the PC. However when editing the frames on the PC you need to follow 
this procedure: 

a. When you get to a blank frame, click the “Reset Pinfall” button. (For more 
information, please refer to the section titled Adding Frames). 

b. Enter the pinfall as normal. 
c. Repeat this for each incomplete frame. 

(3) There is currently no online help available. Refer to these instructions for 
assistance OR contact us via email at support@mybowlingdiary.com 

(4) You must click the “Next Frame” button after the 10th frame. This will take you to 
the game score screen. 

Data Storage and Retrieval 
The handheld version of MyBowlingDiary uses a different database than that of 
MyBowlingDiary for the PC. The databases are separate and distinct and have the 
following limitations: 

• Data from the PC cannot be synchronized to the handheld 
• Data from the handheld is sent to the PC during a “HotSync” or during an Active 

Sync operation. 
• The database on the PC is considered to be the ‘master’ database. 

 
Think of the handheld as a “notebook” of sorts for MyBowlingDiary. You would use the 
following process to get data from the handheld to the PC: 

(1) Use the handheld to enter your bowling information 
(2) Synchronize the handheld to the PC as normal 
(3) Use MyBowlingDiary on your PC to add that information to the database. 
(4) Once that information is entered into your PC database, it can be treated as any 

other event, i.e. you can edit it, run reports and the like. 
(5) You have the option of deleting the data from the handheld once it has been 

entered. If you choose this option, then the records that you previously entered on 
the handheld will be deleted from the handheld. If space is an issue, you will want 
to consider this option. 
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Supported Handheld Devices 
• Pocket PC 2002 
• Pocket PC 2003 
• Palm OS versions 4.x and higher 

 
At the time of this writing, testing has been performed on the following devices: 

• iPAQ 3800 
• Palm Zire 31 

Installation 
Please refer to the MyBowlingDiary 2.0 Installation Guide for instructions on installing 
MyBowlingDiary 2.0 on your handheld device. 

Starting MyBowlingDiary 
Pocket PC: 

• Tap “Start” -> “Programs” -> “MyBowlingDiary” 
 
Palm: 

• When MyBowlingDiary is installed on the Palm, it is usually installed in the 
“Unfiled” category. You will want to go there and find the “MyBowlingDiary” 
icon, and tap it. 

•  
Once launched, you will see the main menu: 
 

Figure 2 - Handheld Main Menu 
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The main menu has these options: 

• Add Event – Adds a new event to the database 
• Edit Event – Edits an existing event that resides in the handheld database 
• Database Statistics – Database statistics for events currently in the handheld. 

These are events that are currently on the handheld device and not 
necessarily in the MyBowlingDiary PC database. 

• Help  
• About – Information on the current version 
• Exit MyBowlingDiary 

 
Use your handheld menu option to select the desired function. Most screens have 
command buttons that are identical to the menu options. 
 

Adding Events 
An event is the cornerstone to MyBowlingDiary. An event can be a league night, 
tournament or practice session. All of the games and frames that you enter are associated 
with events. To add an event, select “Add Event” from the main menu. You will see this 
screen first: 
 
    Figure 3 – Handheld Event Information Screen 

  
 
Available fields: 

• Event Name: Name of the event. This is a required field 
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• Date Bowled: Date that the event was bowled. The default is the current date. If 
you change the date, this must be in M/D/YYYY format. This is a required field. 

• Center name: Name of the bowling center 
• Location: Location of the bowling center 

 
To change information in a field, tap the text box next to the field. You can use any 
method of typing that is available to enter the information. You will have to tap the text 
box in each field in order to enter information for that field. 
 
Pocket PC Users: If you use the keyboard, the screen will be resized to allow you to see 
the keyboard as well as the fields – this is known as SIP resize.  
 
Available options: 

• Next Screen: Toggles to the next screen to enter additional event information 
• Next Event: Saves the current information and adds a new event. (If you are 

editing events this will toggle to the next event on the handheld) 
• Previous Event: Not available when adding events. If you are editing events, this 

brings up the previous event in the handheld database. 
• Reset Form: Resets the form fields to their default values 
• Main Menu: Saves the current event and brings you back to the main menu 
• Exit: Saves the current event and exits MyBowlingDiary 

 
Comments are available on the next screen. After editing the event information, click 
“Next Screen”. 
 

Figure 4 – Handheld Event Information Screen 
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Available fields: 

• Event Type: Allows you to select the type of event (i.e. League, Tournament or 
Practice). This is a required field. 

• Comments: Allows you to enter comments. 
 
Note at the top of the screen you will see the event name and the date bowled. To edit this 
information, tap the box next to the desired event type, and add comments if desired.  
 
Available options: 

• Add Games: Saves the event and allows you to add games to this event. 
• Reset Form: Resets the form fields to their default values 
• Previous Screen: Takes you back to the previous screen 
• Main Menu: Saves the current event and brings you back to the main menu 
• Exit: Saves the current event and exits MyBowlingDiary 

Helpful Hints 
(1) You can enter your event information in advance of your session. For example if 

you are bowling a league, you can enter that information in advance. Here is how: 
a. Launch MyBowlingDiary on your handheld and select “Add Event” 
b. Enter the event information (see Figure 2 - Handheld Main Menu), and the 

event type with optional comments (see Figure 4 – Handheld Event 
Information Screen). 

c. Click “Exit”. Do not sync your handheld. 
d. When you are bowling, launch MyBowlingDiary again. Select “Edit 

Event” and select the desired event by toggling the “Next Event” button. 
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Adding Games 
To add games, click “Add Games” from the event information screen (Figure 4). You will 
see the following screen: 
 

Figure 5 - Handheld Game Information Screen 

  
 
Note that the event information as well as the game number is filled in. 
 
Available Fields: 

• Start Lane: This is the lane where you bowled the first frame of the game. 
• Lane Condition: If desired, enter some comments about the lane condition 
• Comments: If desired, enter additional comments 
• Game Score: If you know the game score you can enter it here, otherwise you can 

leave it blank 
 
Available options: 

• Add Frames: Saves the current game and brings up the Frame Information Screen 
• Event Screen: Saves the current game and brings up the Event Information Screen 
• Next Game: If adding a new event, this saves the current game and brings up a 

new game information screen. 
• Reset Form: Resets the form fields to their default values 
• Previous Game: Not available when adding games. If editing games, this toggles 

to the previous game in the handheld database that is associated with the current 
event. 

• Main Menu: Saves the current game and brings you back to the main menu 
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• Exit: Saves the current event and exits MyBowlingDiary 
 
To add frames, tap the “Add Frames” button. You will see the following screen asking if 
lanes alternate between frames (typical for tournaments and leagues): 
 

Figure 6 - Alternate Lanes Option 

  
 
Tap “Yes” if lanes alternate, and “No” if you do not alternate lanes. 
 

Adding Frames 
To add frames, tap the “Add Frames” button from the game information screen (Figure 
19). You will see this screen 
 

Figure 7 - Handheld Frame Infomration Screen 

  
 
Note that the event information as well as the frame and game number are filled in. 
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Available Fields: 
• Ball Used: If desired, enter the ball used in the frame 
• Foot Pos: If desired, enter the foot position on the lane 
• Lane Tgt: If desired, enter the lane target 

 
Available options: 

• Next Screen: Saves the frame and takes you to the next frame information screen 
• Reset Form: Resets the form fields to their default values 
• Game Info: Saves the current frame and takes you back to the game information 

screen (Figure 5). 
• Next Frame: Not available when adding frames. When editing frames, will toggle 

to the first ball of the next frame. 
• Reset Pinfall: Resets the pin boxes and pinfall to the first ball 
• Event Info: Saves the current frame and goes to the frame information screen 

(Figure 3) 
• Next Ball: Not available when adding frames. When editing frames, this will take 

you to the next ball in the frame. 
• Main Menu: Saves the current frame and brings you back to the main menu 
• Exit: Saves the current event and exits MyBowlingDiary 
 

To enter frame information: 
(1) Ball Used: If desired, enter the ball used 
(2) Foot Pos: If desired, enter the foot position on the approach 
(3) Lane Tgt: If desired, enter the target on the lane 
(4) If your ball was a strike, tap the “Yes” box under the “Strike?” box. Otherwise 

check no. When either of these two boxes are checked, you will see a “Done” 
button next to the “No” box.  
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Figure 8 – Entering Pinfall 

 
 
(5) If your first ball was a strike, you can click the “Done” button that will take 
you to the next screen. Otherwise, tap the boxes that correspond to the pins you 
MISSED on the first ball. In this example, we will show how to record leaving a 2 
– 9. 
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Figure 9 - Entering Pinfall 

 
 

(6) Click the “Done” button that will take you an identical screen. If you converted 
the spare, click “Yes” then the “Done” button. Otherwise click “No”, tap the boxes 
corresponding to the pins you MISSED, then click the “Done” button. This will take 
you to the next screen. 
 

Figure 10 - Handheld Event Information Screen 
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(7) Enter comments if desired. 
(8) Tap “Next Frame” to enter a new frame 
 
Available Fields: 

• Comments: If desired, comments regarding the frame 
 

Available options: 
• Next Frame: Saves the frame and takes you to a new frame (Figure 7). You also 

need to do this after the 10th frame. 
• Game Info: Saves the current frame and takes you back to the game information 

screen (Figure 5). 
• Previous screen: Takes you to the previous screen 
• Event Info: Saves the current frame and goes to the frame information screen 

(Figure 3) 
• Reset Form: Resets the form fields to their default values 
• Main Menu: Saves the current frame and brings you back to the main menu 
• Exit: Saves the current event and exits MyBowlingDiary 

 
Last frame: 
When the 10th frame has been entered, you will see a message that you have entered the 
last frame in the game.  

 
Figure 11 - 10th Frame Message 

  
 
After you click OK, you will be prompted to enter the score 
 



 

MyBowlingDiary 2.0 User Guide  15 

Figure 12 - Game Score Confirmation Screen 

  
 
After tapping the “OK” button you will see the game score screen: 
 

Figure 13 - Game Score Screen 

  
 
After entering the score, tap the “Continue” button. You will then see another dialog 
asking you if this is the last game for the event. If you tap “Yes” then you will be 
returned to the Main Menu (Error! Reference source not found.). If you click “No” you 
will be returned to the game information screen to enter another game. 

Editing Events 
To edit events, select “Edit Event” from the main menu. You will see the events that are 
currently in the handheld database. The ordering of events is mainly from “first entered’ 
to “last entered”. 
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In the event screen, use the “Next Event” and “Previous Event” button to toggle between 
events. Editing events along with their associated games and frames is much like adding 
information. 

Getting Handheld Data to the PC 
Getting handheld data to the PC is a two-step process: 

(1) Ensure that you have the handheld properly set up 
a. Pocket PC Users: No additional setup is necessary before synchronization. 
b. Palm OS: You must first set up your handheld. You MUST know the 

location where your HotSync software is set up. 
(2) Sync your handheld with your PC 
(3) Run MyBowlingDiary (PC version – see Starting MyBowlingDiary) and select 

“Add Data” -> “Add From PDA” from the Main Menu (Figure 17).  
 

Overview 
The database files from the handheld are stored in the C:\Program Files\Common 
Files\MyBowlingDiary\MYBD folder. These files are named tblEvent.cdb, tblGame.cdb 
and tblFrame.cdb that hold event, game and frame information respectively. These files 
are updated whenever the handheld is synchronized with the PC. It is recommended that 
you DO NOT try to edit these database files directly unless instructed to do so by 
support. 
 
When you use MyBowlingDiary to synchronize these files with your ‘master’ database, 
the following events take place: 

(1) The current database files are copied to a folder named PDA DB Archive which is 
under the C:\Program Files\Common Files\MyBowlingDiary\MYBD. Each file is 
given a unique timestamp. This timestamp is created when the synchronization is 
started. 

(2) Two logs are created. The first log is PDASyncLog-Master.log. This log records a 
summary of each synchronization, including the unique timestamp. 

(3) The other log is located in the archive folder. This log is named PDASyncLog-
<timestamp>.log which shows the results of the synchronization. If for some 
reason the previous database files need to be restored, you can use the timestamp 
to determine the correct files. 
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Synchronization Process 

Known Issues 
The following are known issues with the synchronization process and will be corrected in 
a later release: 

(1) After doing a handheld -> PC synchronization you may see the following error 
messages: 

 

 
 

 
 
These are caused by database timing and sharing issues. The database and the 
synchronization is NOT affected by these messages. 

Handheld Setup 
If you are using a Pocket PC, you can skip this step though it is recommended to set your 
handheld up. If you are using a Palm Pilot, this is required. To set up your handheld, 
select “File” -> “Handheld Setup” to get this screen. 
 
 
Figure 14 - Handheld Setup Screen 
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(1) Select the type of handheld you are using 
(2) Select the folder where synchronization takes place.  

a. Palm OS: The default folder is C:\Program Files\Palm\<user>\MYBD 
where <user> is your handheld user name. The folder is where you 
installed your HotSync software.  

b. Pocket PC: Your default synchronization directory is usually in 
C:\Documents and Settings\<username>\MyDocuments\<PDA Name> 
MyDocuments where 

i. Username is your username 
ii. PDA Name is the name that you assigned to your Pocket PC 

(3) Once the directories are set up, click “Save” to save the information to the 
configuration file. 

Synchronization with PC 
Synchronize your handheld to your PC as you normally would.  
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Add Data from Handheld to MyBowlingDiary 
(1) Start MyBowlingDiary 
(2) From the main menu, select “Add Data” -> “Add From PDA” 
 

Figure 15 - PDA Synchronization Screen 

 
 
(3) Select “Add PDA Data” from the command button or the “Commands” menu 
(4) Click “OK” to clear the next dialog box 
(5) The next screen asks if you want to delete the PDA data on the next 

synchronization. Select “Yes” to delete the PDA data and “No” if you do not wish 
it to be deleted (we recommend that you delete the PDA data to maintain 
consistency and to preserve space on the handheld). 

(6) On occasion, one or more events that is in the PC database may conflict with an 
event that is on the PC. In that event you will see a dialog box with the conflicting 
information, including the event name and date. You will have a choice of either 
saying “Yes” to add the event or “No” if you do not want the event added. 

(7) When the synchronization is complete you will see the following dialog 
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Figure 16 - Synchronization Complete 

 
 

(8) Click “OK” to clear the dialog and return to the synchronization screen. At this 
point, the events from the PDA are now in the database. 

Log Files 
If you run into problems during the synchronization, you can view the log files. 
 
Master log file entry: 
MyBowlingDiary PDA Sync started at 9/5/2005 10:12:00 PM 
Timestamp: 09-05-2005-2212 
Log file: C:\Program Files\Common Files\MyBowlingDiary\MYBD\PDA DB 
Archive\PDA_SyncLog-09-05-2005-2212.txt 
 
This will give you the location of the particular log file. Go into the directory and look at 
the log file. The log file is very detailed, giving you progress on each event, game and 
frame that was entered. 
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Using MyBowlingDiary for PC  

Known Issues 
The following are known issues for this release of MyBowlingDiary for the PC (v2.xP). 

(1) Reports cannot be directly synchronized with a Palm handheld. This is due to 
Palm OS functionality. A workaround IS available from 
support@mybowlingdiary.com. Pocket PC users are not affected by this issue. 

(2) The “Repair Database” function has been temporarily removed from the Database 
Tools menu. Since this was used with earlier versions of MyBowlingDiary (to 
correct NULL values) this should have no impact since these values are already 
being checked. 

(3) If you have a trial license that has expired, you cannot use the “Change License 
Key” function to change your license key. Please contact 
support@mybowlingdiary.com for assistance. 

Starting MyBowlingDiary 
To run MBD, click on “Start > Programs > MyBowlingDiary > MyBowlingDiary”. 
During this time your license is validated. You will see a popup window with your 
license information (see Figure 1 - License Status Screen) and if your license is valid you 
will be taken to the main menu. 
 
Figure 17 - Main Menu 

 
 
From the main menu the following options are available: 

• File menu  
o Handheld Setup – If your copy of MyBowlingDiary is licensed for 

handheld operation, this item is available. This allows you to set the 
parameters for your handheld (see Handheld Setup). 

o Exit – Exits MyBowlingDiary 
• Data 

o Add Data –  
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! Add From PDA – If your copy of MyBowlingDiary is licensed for 
handheld operation, this allows you to add data from your PDA to 
your PC. 

! Add From Form. See Event Information to help you get started on 
data entry. 

o Edit Data – Edit existing data. See Editing Data to help you edit event 
information. 

o Database Tools – This brings up a separate window to allow you to run 
certain utilities. See Database Tools for more information. 

o Reports – Brings up the Reports menu screen. See Reports to help you get 
started running reports. 

• Help  
o MyBowlingDiary Help – Brings up on line help for MyBowlingDiary (in 

addition, pressing F1 from any screen will also bring up the help screen). 
o About – Brings up the information screen, including copyright information 

and your serial number. Should you ever need support, you will need the 
serial number (The database statistics and the “License Status” operation 
in “Database Tools” also contains the serial number). 

 
You can also create a shortcut to the MyBowlingDiary executable. Simply open 
Windows Explorer, browse to where MyBowlingDiary is installed and right – click with 
your mouse on the “MyBowlingDiary” icon. Select “Create Shortcut” and the shortcut 
will be put into the same folder. You can then move that shortcut to your desktop. 

Data Entry 
MBD gives you the opportunity to enter information on each event, game bowled and 
frame that you bowled. You can record as much or as little information as you feel 
necessary. Data is divided into the following sections: 
 

• Event Information: 
o Event Name 
o Date Bowled (required) 
o Center Name 
o Center Location 
o Event Type (Practice, Tournament or League) 
o Comments – Comments for event, game and frame can be up to 255 

(approximately 3 lines) of characters. 
• Game Information 

o Game Number (required) 
o Lane pair (required) 
o Game Score 
o Lane Condition 
o Comments 

• Frame Information 
o Frame Number (required) 
o Lane Bowled (required) 
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o Pinfall (all pinfall is required) 
o Foot Position 
o Lane Target 
o Comments 
o Ball Used 

Menus and Navigation 
You will notice that most of the screens contain a menu bar as well as buttons. For 
example: 
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Figure 18 - Event Information Screen 

 
 
If you are familiar with Windows, you can use the “Alt” key along with the letter to 
access a menu option. In this case, typing “Alt-V” will bring up the Event menu, which 
contains the same options as the command buttons at the bottom of the screen. 
 
If a menu option or command button is “grayed out” (as in the “Update Event” button) 
that means that the command or menu option is not available in that screen. 
 
To navigate between text boxes and command buttons, use the “TAB” key on your 
keyboard or move your mouse to the text field and click on the field. 

On Screen Help 
Help is available for MyBowlingDiary in two ways: 

• Pressing the “F1” key from any screen will bring up the help screen 
• Moving your mouse over a specific field, button or section will bring up a short 

synopsis of the functionality. 
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Reports 
The following reports are available with MBD: 

1. Event Reports 
a. Full report 
b. Statistical Summary 

2. Database statistics 
3. Statistical reports by event type 

a. These statistical reports can be filtered by event name and a date range 
4. Game Reports 

 
More information on generating reports can be found in the Reports section. 

Entering Data 

Event Information 
Entering data in MBD begins with entering the event information. Start a new event by 
selecting “Data -> Add Data” from the main menu. The event information screen will 
appear (see Figure 18 - Event Information Screen). 
 
When entering data, you do not need to enter all your data in one sitting. You can use the 
edit functions to add more data at a later time. 
 
Command Summary 

• Next Event: Saves the current event record and brings up another screen to enter 
information on another event. Available only when adding data 

• Update Games: Saves the current event record and brings up the screen to allow 
you to update games or add games from that event 

• Reset Form: Clears all text boxes. Use this if you make a mistake. 
• Previous Screen: Returns you to the previous screen 
• Main Menu: Returns you to the main menu 
• Exit: Exits MBD 

 
Entering Event Information 

• Event Name: Name of the event 
• Date Bowled: This must be a valid date. Note that the current date is filled in. You 

cannot fill in a date that is in the future. 
• Center Name: Name of the bowling center 
• Location: Location of the bowling center. If the name of the bowling center 

already exists in the database, then the location is already filled in for you. 
• Total games bowled: Number of games bowled in the event 
• Event type: Click the button that corresponds to the type of event; League 

(default), Practice or Tournament. 
• Comments: Fill in any comments that may be appropriate. If there is information 

for which there is not a specific field, it can be filled in here. 
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To save the event information, click on (or navigate to) “Next Event” if you want to enter 
another event, or “Input Game” if you want to input your games for the current event. 
Normally you would use “Input Game” to allow you to input games. 

Game Information 
After an event has been added to the database and you click “Input Game” the following 
screen will appear: 
 
Figure 19 - Game Information Screen 
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Command summary 

• Next Game: If you are adding a new event, then clicking this button will save the 
current game and bring up a new screen to add a new game. If you are editing an 
existing event, then clicking this button will toggle to the next game in the event. 

• Previous Game: If you are editing an existing event, then this will toggle to the 
previous game in the event. This is only available when editing existing data. 

• Update Frames: This will bring up the “Frame Information” screen to allow you 
to add frames to a game or edit existing frames. 

• Reset Form: Clears all text boxes. Use this if you make a mistake. 
• Previous Screen: Returns you to the previous screen 
• Main Menu: Returns you to the main menu 
• Exit: Exits MBD 
 

Entering Game Information 
• Note that the “Game Number” field cannot be edited. 
• Lane Pair: The lane pair is divided into the left lane (“L”) and the right lane (“R”), 

allowing you to enter each lane separately. The left lane must be an odd number 
(i.e. 1, 3, 5, 7…) and the right lane must be immediately adjacent to the left lane. 

• Start Lane: Choose one of these buttons to select the lane that you started on in 
this game. The lane number in the frame information screen will be updated 
accordingly. 

• Game Score: If desired, enter the game score. You can also enter a 0 for the game 
score and let MyBowlingDiary calculate the score for you. 

• Lane Condition: If desired, enter the lane condition. This is a “free form” area 
where you can enter any text you like (up to 255 characters). 

• Comments: Enter comments as appropriate 
• Scoring Type: Select the type of scoring you will be doing in this game. The 

choices are “Pinfall” and “Line Score”  
o “Pinfall” is the more versatile of the two choices; however it requires a bit 

more recordkeeping than the “Line Score”. With the “Pinfall” option you 
actually record the pins that you knocked down and the pins (if any) you 
left standing. Entering pinfall allows you to access reports on spare 
shooting. 

o “Line Score” is the easier of the two choices; because you simply enter the 
game score like it would appear on the score sheet. However the “Line 
Score” option limits your reporting capability in that the reporting on 
spare shooting is limited to average spares per game and single pin spare 
conversion percentage. 

 
To save the information, click on “Next Game” or “Update Frames”. 
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Frame Information 
If you are a previous user of MyBowlingDiary, then you will notice changes in the 
“Frame Information” screen from earlier versions. You will want to review this section to 
become familiar with the functionality. 
 
When entering frame information the following screen appears: 
 
Figure 20 - Frame Information Screen 

 
 
Command Summary: 

• Reset Pinfall: This clears all of the pinfall from the screen. This works when you 
are editing as well as entering new frames. 

• Pinfall Entry Help: This brings up a separate window that contains a tutorial on 
entering pinfall 

• Next Frame: In edit mode saves the current frame information (if changes were 
made) and goes to the next frame in the game. This also adds a new frame to the 
database when adding new frames. 
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• Previous Frame: In edit mode saves the current frame information (if changes 
were made) and goes to the previous frame in the game. 

• Reset Form: Clears all text boxes. Use this if you make a mistake. 
• Previous Screen: Returns you to the previous screen 
• Main Menu: Returns you to the main menu 
• Exit: Exits MBD 
 

Entering Frame Information 
• Frame number: Enter the frame number 
• Lane: The lane number should be filled in for you, but you can also edit this if 

necessary. For example, if you are entering an event where you bowled on only 
one lane, you will have to change the lane number to reflect the correct lane. 

• Ball used: If desired, enter the ball that you used. This information will be carried 
over to the next frame to make data entry easier. However the field can be edited. 

• Foot position: If desired, enter the starting position of your feet on the lane. This 
information will be carried over to the next frame to make data entry easier. 
However the field can be edited. 

• Lane target: If desired, enter the point on the lane where your target is. This 
information will be carried over to the next frame to make data entry easier. 
However the field can be edited. 

• There are two ways to enter your pinfall: 
o Line Score: If you selected the “Line Score” option you can enter your 

score in the boxes (outlined in red). You would enter this in the same way 
it would appear on a score sheet (see Figure 21 - Line Score Entry Example). 
Acceptable values for the line score are the numbers 0 – 9, “/” and “X”. IN 
addition you can only enter valid frames such as X, 8/, 90 and so forth. If 
you enter an unacceptable value, you will be prompted to reenter the 
pinfall for that frame. 
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Figure 21 - Line Score Entry Example 

 
 

o Pinfall: If you selected the “Pinfall” option, that is entered into one of the 
"frames" or "boxes" (marked "Pinfall - 1st Ball", "Pinfall - 2nd Ball" and 
"Pinfall - Fill Ball"). The "Yes" and "No" buttons (under the "Strike?" or 
"Spare?" captions) are used to select if you got a strike or spare on the 
ball, depending on which shot you are entering. The checkboxes 
(underneath the "Pins Standing" caption) represent each of the 10 pins, 
and are checked if you left that pin standing after your shot. When you add 
a new frame, the "Yes" and "No" buttons for the first ball are enabled 
automatically. In addition, using the Pinfall option will also automatically 
populate the “Line Score” box (see Figure 22 - Pinfall Entry Example). 
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Figure 22 - Pinfall Entry Example 

 
 
To enter your pinfall, follow these steps: 
1) For your first ball, use the "Pinfall - 1st Ball" frame: 

a. If you got a strike on your first ball, click the "Yes" button. Except 
for the 10th frame, this completes the pinfall entry. 

b. If you did not get a strike on your first ball, click the "No" button. 
Then check the boxes that correspond with the pin(s) you left 
standing on your first shot. When you are finished checking the 
boxes, click the "Done" button in the lower left hand corner of the 
frame. 

2) For your second ball, use the "Pinfall - 2nd Ball" frame and follow the 
instructions for the first ball, i.e. check the appropriate boxes and click 
“Done”. Note that when you are entering pinfall for your second ball, you 
can only check those boxes that correspond to the pins left on the first ball. 
For example, if you left a “2-4-5” on your first ball, you can only check 
the “2-4-5” boxes on your second ball. 

3) If you got a mark (strike or spare) in the 10th frame, you will need to 
record your fill ball. This is the same as the first or the second ball. 
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4) If you are missing pinfall, you will have to re-enter the pinfall for that 
frame. 

• Comments: Enter comments as appropriate.  
• To move on to the next frame, click “Next Frame”. You will be prompted if any 

pinfall is missing. 
 
When all 10 frames are entered (in both line score and pinfall mode), you will see this 
dialog box: 
 
Figure 23 - Complete Game Dialog Box 

 
 
Click “Yes” to clear the dialog box. Once the dialog box is cleared, your score will be 
calculated. If the score that was calculated differs from the score that was entered in the 
game information screen you will see a dialog box showing a mismatch. Click “Yes” to 
use the calculated score and “No” to retain the previous score. 
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Editing Data 

Editing Events 
Most data in MBD can be edited. To edit data, select “Edit Data” from the main menu. 
You will see a popup that looks like this: 
 
Figure 24 - Edit Event Search Dialog 

 
 
When you click OK, this screen appears: 
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Figure 25 - Event Selection Screen 

 
 
Command Summary: 

• Retrieve Event: Retrieves a highlighted record for editing 
• Delete Event: Deletes a highlighted record from the database 
• Previous Screen: Returns you to the previous screen 
• Main Menu: Returns you to the main menu 
• Exit: Exits MBD 

 
To edit an event, select the event (only one event at a time can be selected), highlight it 
and click “Retrieve Event”. The event screen appears (see Figure 18 - Event Information 
Screen). Change the data as necessary, and then click “Update Games” or “Update Event”. 
See the previous section for more information on these command buttons. 

Editing Games 
If you selected “Update Games” from the Event Information screen, all of the games that 
are associated with the event will be loaded, and the Game Information screen will be 
loaded with the first game of the event. The only field that cannot be edited in the Game 
Information screen is the game number.  
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After editing the game information, you can either select any of the available options to 
save your updated record. If the number of games in the record is less than the number of 
games for the event, you can also click “New Game” to add a new game to the record. 

Updating Frames 
If you selected “Update Frames” from the Game Information screen, all of the frames for 
that game will be loaded, and the first frame will appear on the screen such as this: 
 
Figure 26 - Edit Frame 

 
 
Any of the data fields (with the exception of the frame number) can be changed. 
 
To change the pinfall for that frame, click the “Reset Pinfall” button to clear the pinfall. 
This will clear the pinfall without clearing the other data in the frame. After the pinfall is 
cleared you can enter the correct pinfall as if you are adding a new frame (see Frame 
Information). 
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Reports 

Reports Menu 
Selecting “Reports” from the main menu will bring up the following screen: 
Figure 27 - Reports Menu 

 
 
The following options are available from the reports screen: 

• File: 
o Open – This is provided so that you can open up an existing report in 

Windows Notepad, but can open virtually any file that you have in your 
system. 

o Exit – Exits MyBowlingDiary 
• Report 

o Event Reports – Brings up the Search Event screen. See Event Report. 
o Game Reports – Brings up the Search Game screen. See Game Reports. 
o Statistical Reports – Brings up the Statistics screen. See Event Statistics. 
o Return to the Main Menu – Returns you to the main menu. 

• Help 
o MyBowlingDiary Help – Clicking this or pressing the “F1” key brings up 

online help. 
o About – Brings up the program information. 

 
 

Event Report 

About Reports 
The default location for all MyBowlingDiary reports is in 
<INSTALLDIR>\MyBowlingDiary\Reports. <INSTALLDIR> is the top level directory, 
which by default is c:\Program Files\MyBowlingDiary.  
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When creating a report, the report name is created by default. For example a dialog box 
that will pop up when creating an event report is like this: 
 
Figure 28 - Report Dialog Box 

 
 
You can change the location of the report by simply browsing to the folder where you 
would like the report saved. You can also change the filename by typing the name of the 
report in the text box next to “File name”. Click “Save” to run the report. If a file with the 
same name already exists, you will be asked if you want to overwrite the file.  
 
This functionality is the same for all reports. 
 

Event Reports 
 
To get a report on an event, select “Data -> Reports” from the main menu. The “Reports” 
menu screen appears: 
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Figure 29 – Report Menu 

 
 
From the “Report” menu, select “Event Reports”. The following search screen appears: 
 
Figure 30 - Event Search Screen 
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Command Summary: 
• Begin Search: Searches all events based on the search parameters 
• Reset Form: Resets and clears all text from the search screen 
• Previous Screen: Returns you to the previous screen 
• Main Menu: Returns you to the main menu 
• Exit: Exits MBD 

 
There are three columns. You can enter up to five different attributes to search for. 

• Search for: This is the field or attribute of the event that you want to search for. 
Available attributes are 

o Center Name 
o Date Bowled 
o Event Name 
o Event Type – can be Practice, Tournament or League 
o Number of Games 
o Series Average  
o Series Total 
o Comments 

Click the right most portion of the box until the search parameter you want appears. 
Highlight it to select it. 

 
• That: This is the “operator”. Available operators differ depending on the search 

parameter. 
o For Center Name, Event Name or Comments: 

! Is: Searches for events containing the exact value contained in the 
“Value” column. These text searches are not case sensitive. In 
other words, “Bowl” would search for bowl regardless of the case 
of the letter. 

! Contains: Returns any rows containing the text that is in “Value” 
(not case sensitive). 

o For Date Bowled 
! Is on: Searches for events occurring on a certain date 
! Is on or before: Searches for events occurring on or before a 

certain date 
! Is on or after: Searches for events occurring on or after a certain 

date 
! Is before 
! Is after 

o For Number of Games, Series Average or Series Total: 
! Is equal to 
! Is equal to or greater than 
! Is equal to or less than 
! Is greater than 
! Is less than 

 
• Value: This is the value you are searching for 
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After entering the first row, press the “TAB” key. If you want to enter another attribute, 
click the checkbox at the left of the row, then click either the “AND” or the “OR” button. 
For example: 
 
Figure 31 - Search Example Using AND 

 
 
This search will return all events that contain the word “Friday” in the event name, and 
“Merrimack” in the center name. 
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Figure 32 - Search Example Using OR 

 
 
This search will return all events that either: 

1. Were bowled before 4/20/2004 OR 
2. Have a series average greater than or equal to 200 

 
Click the “Begin Search” button to start the search. When the search is complete, you 
will see a screen similar to the one for editing events: 
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Figure 33 - Event Report Selection Screen 

 
 
 

1. Highlight the desired record – this is easily done with a mouse click. 
2. In the “Select Report Type” frame, select a “Full Report” or a “Summary Only” 

a. A “Full Report” gives you all information on that event, including pinfall 
and comments for each frame. This also includes the summary 
information. 

b. A “Summary Only” gives you the event summary, results of each game 
and the following information at the end of the report: 

A. Series total 
B. Series Average 
C. Number of strikes, strike percentage and average per game 
D. Number of spares, spare percentage and average per game 
E. Number of open frames and average per game 
F. Single pin spare statistics, including percentage. This is derived 

from games where both “Pinfall” and “Line Score” mode were 
used to record the frame information. 

G. Spare percentage summary, which is a compilation of all spares 
attempted and converted. This is derived from games where the 
“Pinfall” mode is used  
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3. Click on “Retrieve Record” to create the report. Once the report is generated, you 

will receive a message stating that the report was created, (with the location) and 
then you are returned to the Event Listing screen. 

Event Statistics 
Event statistics are a great way to track your progress for all event types (League, 
Practice and Tournament) or for one of the specific event types. An event statistics report 
has the following information: 
 

A. Event type, event name (if filtering by a specific event) and date 
range 

B. Number of events, games, pinfall and average 
C. Event milestones which include: 

1. Number of games bowled with specific range scores, i.e. 
under 100, 100 – 119, 120 – 139, etc. 

2. High / low series, grouped by number of games bowled in 
the series 

3. High low game 
D. Number of strikes, strike percentage and average per game 
E. Number of spares, spare percentage and average per game 
F. Number of open frames and average per game 
G. Single pin spare statistics, including percentage. This is derived 

from games where both “Pinfall” and “Line Score” mode were 
used to record the frame information. 

H. Spare percentage summary, which is a compilation of all spares 
attempted and converted. This is derived from games where the 
“Pinfall” mode is used  

 
In addition, these events can be filtered by a date range as well as by the event name. 
When you select “Statistical Reports” from the Reports menu, you will see the following 
screen: 
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Figure 34 - Statistics Screen 

 
 

1. In the “Select Event Type” section, this is where you select the type of event that 
you want to report on: 

a. All Events – Check this box if you want to select all your events 
b. League – Check this box if you only want to report on your league events 
c. Practice – Check this box if you only want to report on your practice 

events 
d. Tournament – Check this box if you only want to report on your 

tournament events 
2. In the “Data Retrieval Options” section, this is where you select your data 

retrieval options: 
a. All Data – Check this box if you want to select all the data 
b. Filter Data – Check this box if you want to filter the data of the event type 

that you selected: 
i. Date Range: Check this box to select a date range for the events. 

When the box is selected, you can put in a “From” and “To” date 
in the mm/dd/yyyy format (i.e. 5/1/2004). 
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ii. Event Name: Check this box to retrieve data from a specific event. 
When this box is checked, the list box will have a listing of the 
event names available. 

Game Reports 
A game report is available to allow you to run reports based on the following 

• Game Score 
• Lane Pair 

 
To run the game report, select “Data -> Reports” from the main menu, and “Report -> 
Game Reports” to bring up the following screen: 
 
Figure 35 - Game Search Criteria Screen 

 
 
This has the same functionality as the search screen for event reports. You can search on 
the following criteria: 

• Game Score 
• Lane Pair – this must be a valid lane pair, i.e. 1-2, 5-6, etc 

 
Once you enter in the criteria, click “Begin Search” to bring up the Game List screen: 
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Figure 36 - Game Search Results Screen 

 
 
Click “Retrieve Record” to create the report. 

Opening Reports 
All MBD reports are saved in text format. Any file in a text format can be opened with 
Windows Notepad in one of two ways: 

1. The easiest way is to browse for the file with Windows Explorer and double click 
on the file. 

2. From a command line (or “Start -> Run”) you can type “notepad.exe 
<Filename>” where filename is the location of the file. 

3. You can also open reports via the Reports menu. Simply select “File -> Open” to 
bring up the dialog box, and select the file you want to open. The file will be 
opened with Notepad, and will be minimized to your taskbar. You will need to 
click the icon in the taskbar to view the file. 

 
Using Notepad, you can print reports by selecting “File -> Print” from the Notepad menu. 
 



 

MyBowlingDiary 2.0 User Guide  47 

Since these reports are strictly text, they can also be imported into other word processing 
programs such as Microsoft Word. 

Database Tools 
The Database Tools section will allow you to  

• Check database statistics 
• Check database consistency  
• Change your license key 
• Change your serial number 
• Get your license status 

 
To get to the database tools screen, select “Data -> Database Tools” from the main menu. 
 
Figure 37 - Database Tools Screen 

 

Database Statistics 
From the Database Tools screen click the “Database Statistics” button or use “Tools -> 
Database Statistics” from the menu. This will give you the following database 
information in a separate window: 

• Number of events in the database 
• Number of games in the database 
• Number of frames in the database 
• Your product serial number 
• Pathname to the database file 
• Size of the database file 
• Date that the database file was last accessed 
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Figure 38 – Database Statistics Dialog Box 

 
 
Click “OK” to clear the database window. This will bring you back to the main menu. 

Integrity Check 
The integrity check is useful to maintain database integrity. For example if you used 
Access to access the database and accidentally deleted an event but not the associated 
games or frames, you may run into problems at a later point if you try to access that 
information. If the integrity check finds such data, it will delete the data from the 
database and note that in the report.  
 
From the Database Tools screen click the “Database Statistics” button or use “Tools -> 
Database Statistics” from the menu. You will be prompted for a location to save the 
report (the default title is DB_Integrity_Report). Each time the check is executed, it 
appends its results to the end of the report such as this: 
 
Database Integrity Check Date: 7/17/2004 10:54:12 PM 
All games in the database checked, no errors. 
All frames in the database checked, no errors. 
Total games deleted: 0 Total frames deleted: 0 
******************************************** 
Database Integrity Check Date: 7/18/2004 10:57:23 PM 
All games in the database checked, no errors. 
All frames in the database checked, no errors. 
Total games deleted: 0 Total frames deleted: 0 
******************************************** 
Database Integrity Check Date: 7/22/2004 6:21:36 AM 
All games in the database checked, no errors. 
All frames in the database checked, no errors. 
Total games deleted: 0 Total frames deleted: 0 
******************************************** 
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Database Report 
The database report is useful to find events that are missing games, games that are 
missing frames and frames that are missing pinfall. If any of your reports say that you are 
missing frames or games, you should run a database report to see where that missing data 
is. 
 
From the Database Tools screen click the “Database Report” button or use “Tools -> 
Database Report” from the menu. You will be prompted for a location to save the report 
(the default title is DB_Report). Each time the check is ran, it overwrites any previous 
report. The report output looks like this (this is an excerpt): 
 
Database Report Date: 7/22/2004 4:22:54 PM 
68 events found. 
Event name: Friday Night Mixed Date bowled: 4/2/2004 Games bowled: 3
 Games recorded: 3 
Event name: Friday Night Mixed Date bowled: 9/12/2003 Games bowled: 3
 Games recorded: 3 
 Game #2, Frame #3 missing second ball. 
 Game #3 No Frames recorded. 
 
This will allow you to look up the events and make corrections as necessary (see Editing 
Data). 

Change License Key 
This option allows you to change your MyBowlingDiary license key. Under normal 
operation, you should never have to change your license key except converting from a 
trial license to a permanent license OR if you have purchased the handheld versions and 
you have been provided a new key. New keys are usually transmitted via email. 
 
When changing the license key, the new license key must be entered EXACTLY as 
shown on the email message with the new key. 

Change Serial Number 
This option allows you to change the MyBowlingDiary serial number. Each user is 
assigned a serial number regardless of whether it is a permanent or trial version. The 
serial number is in no way connected to the license key. 

Check License Status 
This option allows you to check the status of your current license and also allows you to 
get your serial number (required for support). 
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Miscellaneous 

Registration 
Registration of MyBowlingDiary is required to receive support. You can register your 
copy by going to http://www.mybowlingdiary.com/reg_intro.htm. You will need your 
serial number, which can be found on your welcome letter as well as by clicking on 
“License Status” from the “Database Tools” screen (see Check License Status). 

Taking Notes 
(From the developer of MyBowlingDiary) 
So how do you get started taking notes? Let me share what works for me. 

Saving Game Information 
If all you want to do is save game information, then you can simply enter the event 
information, and the game scores and lane pairs for each game. You don’t need to enter 
your frame information. You can get a copy of the recap sheet (or write your scores 
down) and enter the game information, putting in whatever comments you want. 

Saving Game and Frame Information 
If you want to save your frame information as well, here is a proven method to get 
started: 

1. Buy a couple of small 3 x 5 notebooks. You can get these at any drug store or 
office supply store. Get yourself a pencil with a good eraser. Don’t use pen 
because if you need to make corrections pen can be difficult to read. 

2. Before you start your session, go to a blank page in your notebook and note the 
date, event name and other information you want to record. 

3. For each frame I do the following: 
 
L 1-1  Fuel 24-8 
High, 4 / 
 
L: Left lane, R for right lane 
1-1: Game 1, Frame 1 
Fuel: Ball I used 
24-8: 24 is where my left foot is, the 8 is the target on the lane 
 
After I bowl the frame, I note the pinball. If I left pins, I will note the pin 
number(s), any interesting characteristics and if I converted the spare. Hence  
High, 4 / means that the ball came in high, left a 4 pin and I converted the spare. 
If I didn’t convert the spare I would write the pins that I did get. 

 
4. After the event, go home and start MyBowlingDiary. Enter the event and game 

information. Then for each frame, go through your notes and enter your frame 
information. 
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It seems like a lot, but you will get the hang of it after a few games. 
 

Backing up the Database 
The MBD database is located in C:\Program Files\Common 
Files\MyBowlingDiary\MyBowlingDiary_DB.mdb. If you perform regular system 
backups (which is always recommended) then this file should be backed up to your 
system during the normal backup process. Consult the documentation for your particular 
system backup application. 
 
If you do not run regular system backups, it is recommended that you back up your 
database on a regular basis. The database can be backed up to any media such as 
CDROM, floppy disk or USB drives. You can use a regular DOS “copy” command or 
copy it with Windows Explorer. 

Security Issues 
There are no known security issues with MBD, associated DLL files or support files that 
are used during installation and run-time. It is recommended that you always do the 
following: 

1. Install and use anti-virus software on your system 
2. Install all recommended Microsoft patches applicable to your operating system 
3. Keep updated on the latest operating system issues via www.microsoft.com 

 
If a security issue arises that involves any file or component used by MBD, you will be 
notified via email. If necessary, MBD will be updated with the latest patches and DLL 
files. 

Technical Support 
At the present time, technical support is available via email or online chat. Should you 
need technical assistance please follow the steps below: 

1) Check our support page at http://www.mybowlingdiary.com/support.htm 
2) If the information or issue is not resolved by checking our support page you can 

contact us by 
a. Send an email to support@mybowlingdiary.com. Please include the 

following: 
i. Your MyBowlingDiary serial number (see Registration) 

ii. A description of the issue you are having. Please include any error 
messages. 

iii. If you send attachments via email, please scan your attachments 
with a virus scanner before transmitting. 

b. You can chat with us online via Windows Messenger or Yahoo! 
Messenger (hours vary) 

i. For Windows Messenger, please add 
mybowl5@mybowlingdiary.com to your contact list 
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ii. For Yahoo! Messenger please add mybowlingdiary to your 
Yahoo! Messenger contact list. 

Updates 
Product updates will be available as new functionality is added and product issues are 
resolved. Notification will be sent to all customers via email. Therefore it is important 
that you keep your registration records updated with your current email address. If you 
change your email address, or if you would like to verify your information, please send 
an email to support@mybowlingdiary.com. 
 
 
 
 

 
 


